
HAL Id: hal-04598008
https://hal.science/hal-04598008v1

Submitted on 3 Jun 2024

HAL is a multi-disciplinary open access archive
for the deposit and dissemination of scientific re-
search documents, whether they are published or not.
The documentsmay come from teaching and research
institutions in France or abroad, or from public or pri-
vate research centers.

L’archive ouverte pluridisciplinaireHAL, est des-
tinée au dépôt et à la diffusion de documents scien-
tifiques de niveau recherche, publiés ou non, émanant
des établissements d’enseignement et de recherche
français ou étrangers, des laboratoires publics ou
privés.

HAL Authorization

Mechanistic exploration of autophagy and aging by RNA
interference

Hui Pan, Oliver Kepp, Guido Kroemer

To cite this version:
Hui Pan, Oliver Kepp, Guido Kroemer. Mechanistic exploration of autophagy and aging by RNA interference.
Methods in Cell Biology, 2024, Methods in Cell Biology, 181, pp.213-226. ⟨10.1016/bs.mcb.2023.03.003⟩. ⟨hal-
04598008⟩

https://hal.science/hal-04598008v1
https://about.hal.science/hal-authorisation-v1/
https://about.hal.science/hal-authorisation-v1/
https://hal.archives-ouvertes.fr


Mechanistic exploration of autophagy and aging by  

RNA interference 

Hui Pan1,2, Oliver Kepp1,2 and Guido Kroemer1-3 

 

1Metabolomics and Cell Biology Platforms, Gustave Roussy Cancer Center, Université 

Paris Saclay, Villejuif, France; 2Centre de Recherche des Cordeliers, Equipe labellisée 

par la Ligue contre le cancer, Université Paris Cité, Sorbonne Université, Inserm U1138, 

Institut Universitaire de France, Paris, France; 3 Institut du Cancer Paris CARPEM, 

Department of Biology, APHP, Hôpital Européen Georges Pompidou, Paris, France;  

 

Correspondence to: Dr. Oliver Kepp (captain.olsen@gmail.fr), Gustave Roussy 

Cancer Center, Villejuif, France; Prof. Dr. Guido Kroemer (kroemer@orange.fr), 

Centre de Recherche des Cordeliers, Paris, France.  

 

Data availability statement: All data that led to the conclusions in this manuscript 

have been included and all sources have been described. 

 

Key words: Aging, autophagy, cancer, screening 

 

Running title: Mechanistic assessment of cellular senescence 

mailto:captain.olsen@gmail.fr


Abstract 

Cellular senescence is a cellular process with organismal impact that is mechanistically 

counterbalanced to a certain extent by frequent episodes of autophagy. Here we 

describe a detailed, automation-compatible method for the use of RNA-interference 

(RNAi; also called post-transcriptional gene silencing (PTGS))-mediated silencing of 

autophagy related protein-coding gene expression. RNAi is a conserved biological 

response to double-stranded RNA that mediates resistance to endogenous parasites and 

exogenous pathogenic nucleic acids. RNAi mediated by short interfering RNA (siRNA) 

is widely used for gene function analysis. The accurate use RNAi for the inference of 

gene function necessitates that both specificity and efficacy of the siRNA-mediated 

knockdown are monitored. In this manuscript, we exemplify this crucial step employing 

siRNA targeting the autophagy and lysosomal biogenesis associated transcription 

factor TFE3 and validate the specificity on protein and mRNA level.   



Introduction 

Cellular senescence constitutes an intrinsic defense mechanism against progressively 

accumulating damage caused by endogenous and exogenous stress that constrains 

impaired cells in a non-proliferative state 1-4. Autophagy alleviates cellular damage by 

enforcing the turnover of misfolded proteins and malfunctioning organelles thus 

preventing the onset of cellular senescence and counteracting the manifestation of aging 

associated phenotypes and maladies 5-7. One way to mechanistically analyze the impact 

of autophagy on organismal homeostasis in response to cellular damage is the use of 

RNA interference (RNAi) or post-transcriptional gene silencing (PTGS). RNAi is a 

conserved biological response to small double-stranded RNA molecules that mediates 

resistance to endogenous parasites and exogenous pathogenic nucleic acids and 

regulates the expression of protein-coding genes. This natural mechanism of sequence-

specific gene silencing revolutionized experimental biology and found practical 

applications in areas such as functional genomics and therapeutic intervention8,9. Based 

on their biological roles, associated effector proteins, aspects of origin, and structure, 

small RNAs were classified into three broad categories: short interfering RNAs 

(siRNAs), microRNAs (miRNAs), and PIWI-interacting RNAs (piRNAs) 10,11. Due to 

the detailed understanding of the molecular mechanisms of endogenous RNA 

interference, siRNA has become a biochemical tool for the study of protein functions12. 

For the assessment of gene functions the specificity and efficacy of siRNA-mediated 

knockdown must be determined together with the mechanistic analysis. In this 

manuscript, we detail the use of siRNA oligos targeting TFE3 mRNA to reduce the 



expression of TFE3, and describe the workflow for assessing knockdown efficacy by 

immunoblot, RT-qPCR functional validation by fluorescence microscopy. 

  



1. Materials 

1.1 Disposables 

(1) Polystyrene flasks (75 and 25 cm2) and 6-well plates for cell culture 

(2) Conical polypropylene centrifuge tubes (15 mL) 

(3) Pipet-aid and serological pipettes (5 and 10 mL) 

(4) Micropipettes (0.2–2 μL, 1–20 μL, 20–200 μL, 200–1000 μL) and tips 

(5) 0.5 ml and 1.5 mL microcentrifuge tubes 

(6) Cell counting slides 

(7) Precast 4–12% polyacrylamide NuPAGE Bis–Tris gels (Life Technologies, 

Carlsbad, California, United States)  

(8) Polyvinylidene difluoride (PVDF) membrane (Millipore Corporation, Burlington, 

Massachusetts, United States) 

(9) Poly-D-lysine precoated 96-well or 384-well plates for microscopical assessment  

 

1.2 Equipment 

(1) Cell culture incubator allowing for standard cell culture conditions in a humidified 

atmosphere (37°C, 5% CO2) 

(2) Sterile cell culture laminar flow hood safety level II 

(3) Standard cooled bench top centrifuge 

(4) Orbital shaker 

(5) XCell SureLock Mini-Cell electrophoresis system (Invitrogen, Thermo Fisher 

Scientific, Waltham, Massachusetts, United States) 



(6) Mini-PROTEAN Tetra cell (Bio-Rad Laboratories, Hercules, California, United 

States) 

(7) ImageQuant LAS 4000 biomolecular imager with appropriate software (GE 

Healthcare Life Sciences, Chicago, Illinois, United States) 

(8) Fluorescence microscope for acquiring images with 20x objectives, and software 

for segmenting images, for example high-throughput ImageXpress micro-XL 

automated microscope and Custom Module Editor of the MetaXpress software 

(Molecular Devices, San Jose, California, USA). 

(9) Software for data analysis and statistical evaluation such as the R software (freely 

available at https://www.r-project.org). 

(10)  Spectrophotometer for assessing RNA/DNA content such as the NanoDrop One 

(Thermo Fisher Scientific) 

 

1.3 Reagents 

(1) Complete medium for cell culture: Dulbecco’s modified Eagle’s medium (DMEM) 

(Thermo Fisher Scientific) supplemented with serum (10% v/v fetal bovine serum) 

(Thermo Fisher Scientific), 1 mM sodium pyruvate and 10 mM HEPES buffer 

(Thermo Fisher Scientific) and antibiotic (100 U/mL penicillin G and 100 μg/mL 

streptomycin sulfate) for the culture of H4 WT and H4 GFP-LC3 cells, stored at 

4°C 

(2) Antibiotic-free complete medium 

(3) 0.05–0.25% Trypsin/EDTA solution (Thermo Fisher Scientific), stored at 4°C 

https://www.r-project.org/


(4) 0.4% Trypan blue solution (Thermo Fisher Scientific) 

(5) 1x Phosphate-buffered saline (PBS) (Thermo Fisher Scientific), pH 7.4 

(6) Recommended DharmaFECT formulation 1/4 and 1x siRNA buffer (or RNase-free 

water) 

(7) Radioimmunoprecipitation assay (RIPA) lysis and extraction buffer (Thermo Fisher 

Scientific) 

(8) Pierce Protease and Phosphatase Inhibitor Mini Tablet, EDTA free (Thermo Fisher 

Scientific) 

(9) Sample loading buffer (Thermo Fisher Scientific) 

(10)  Sample reducing agent (Invitrogen) 

(11)  Pierce™ BCA Protein Assay Kit (Invitrogen) 

(12)  Appropriate molecular weight marker (#26616, Invitrogen) 

(13)  Antibodies specific to TFE3 (#ab93808, 1:2,000, abcam, Cambridge, UK), β-

actin (#ab49900, 1:10,000, Abcam) 

(14)  HRP-conjugated secondary Horseradish peroxidase (HRP)-conjugated secondary 

antibody (Southern Biotech, Cambridge, United Kingdom; 1:10,000) 

(15)  Western blotting detection reagent ECL prime (Thermo Fisher Scientific), stored 

at 4°C 

(16)  Washing buffer (TBST) (1x Tris Buffered Saline (TBS) with Tween20 (1,1000, 

Sigma-Aldrich, St. Louis, Missouri United States) at pH 7.4) 

(17)  Blocking solution (fresh 5% nonfat dried milk diluted (Sigma-Aldrich) in TBST) 

(18)  Antibody dilution buffer (5% bovine serum albumin (BSA) (Sigma-Aldrich) in 



TBST) 

(19)  Running buffer (20x MES SDS running buffer (Invitrogen, Thermo Fisher 

Scientific) diluted to a final 1x ratio in deionized water) 

(20)  Transfer buffer (10x Tris-Glycine buffer (EUROMEDEX) and ethanol (Sigma-

Aldrich) diluted with deionized water at a ratio of 1:2:7) 

(21)  RNeasy Plus Mini Kit (# 74134 and #74136) 

(22)  cDNA Synthesis Kit (#K1641, Life Technologies).  

(23)  Power SYBR Green PCR Kit (#4368706, Life Technologies)  

(24)  Specific siRNAs (GE Healthcare Dharmacon) as detailed below:  

• siCtr (5’-UAGCGACUAAACACAUCAA-3’),  

• siTFE3-#1 (5’-GGAAUCUGCUUGAUGUGUA-3’),  

• siTFE3-#2 (5’-GCUCAAGCCUCCCAAUAUC-3’),  

• siTFE3-#3 (5’-CGCAGGCGAUUCAACAUUA-3’),  

• siTFE3-#4 (5’-CAGAGCAGCUGGACAUUGA-3’) 

(25)  Specific TFE3 primers as detailed below: 

• Forward primer: CCCCTGCCATGTCGTCATC 

• Reverse primer: GTGGACGGCTCAATGTGTG 

 

1.4 Cell culture 

(1) H4 WT and H4 GFP-LC3 cell lines are routinely maintained in standard culture 

conditions (at 37°C, 5% CO2) and cultured in Dulbecco’s modified Eagle’s medium 

(DMEM) supplemented with 10% fetal bovine serum (FBS), 1 mM sodium 



pyruvate, 10 mM HEPES buffer and antibiotic (100 U/mL penicillin G and 100 

μg/mL streptomycin sulfate). After thawing, the cells are adapted to cell culture 

conditions in complete growth medium for at least 1 week. 

(2) Once maintenance cultures reach 70–80% confluence, exhausted culture medium is 

discarded. Thereafter, cells are detached with 0.25% trypsin/EDTA, diluted and 

passaged. This provides cells for maintenance culture as well as for experimental 

procedures. 

(3) Two million H4 WT cells are seeded in standard 75 cm2 polystyrene flasks for cell 

culture, are allowed to adapt until standard proliferation for 24 h, and processed as 

detailed above. 

(4) Seed 2.5 x 105 H4 WT cells (assessed by using Cell counting slides) in 2 mL/well 

in antibiotic-free complete medium in standard 6-well plates, then incubate cells at 

37°C, 5% CO2 overnight and proceed with the RNA interefence protocol. 

 

1.5 RNA interference (adapted from the DharmaFECTTM Transfection Reagents-

siRNA transfection protocol) 

(1) Prepare 5 μM siCtr, siTFE3-#1,2,3,4 in 1x siRNA buffer (See note 1) 

(2) In separate tubes, dilute the siRNA (mark as tube 1) and the DharmaFECT 

transfection reagent (mark as tube 2) with serum- and antibiotic-free medium. 

Tube 1: For each well, prepare 200 μL siRNA solution of each siRNA in serum-free 

medium by adding 10 μL of 5 μM siRNA to 190 μL of serum free medium. 

Tube 2: For each well, prepare 200 μL DharmaFECT transfection solution in serum-



free medium by adding 4 μL (can vary between 1 - 10 μL) DharmaFECT reagent to 196 

μL (can vary between 199-190 μL) serum-free medium. 

 

siCtr siTFE3#1 siTFE3#2 

 siTFE3#3 siTFE3#4 

 

(3) Gently mix the contents of each tube by pipetting carefully up and down. Incubate 

for 5 min at room temperature. 

(4) Add the contents of tube 1 to tube 2, for a total volume of 400 μL. Mix by pipetting 

carefully up and down and incubate for 20 minutes at room temperature, and then 

add 1.6 mL of antibiotic-free complete medium for a total volume of 2 mL siRNA 

transfection solution. 

(5) The culture medium is removed from the wells of the 6-well plate and add 2 mL of 

the appropriate transfection medium to each well. 

(6) Cells are incubated in a cell culture compatible incubator and medium is replaced 

with fresh complete medium after 24 h. For mRNA analysis the time of incubation 

is 24 h; for protein analysis the recommended time of incubation is 48 h. 

 

1.6 Western blot validation 

1.6.1 Sample preparation 

(1) After 48 h of treatment, the culture medium is removed, and H4 WT cells are 

washed twice by PBS (See notes 2,3).  



(2) PBS is removed and the cells are detached with 0.25% trypsin/EDTA and collected 

in complete medium (See notes 4,5). 

(3) An appropriate amount of PBS is added to wash the collected samples twice (See 

note 6). 

(4) Cells are collected and lysed in cold RIPA lysis and extraction buffer (Thermo 

Fisher) containing Pierce Protease and Phosphatase Inhibitor Mini Tablet (Thermo 

Fisher) on ice for 40 min (100 μL per 1x105 cells) (See note 7).  

(5) The samples are ultrasonicated for 3 x 5 s to ensure complete protein dissolving 

(See note 8). 

(6) After centrifugation at 12,000 g for 15 min at 4°C, supernatants are transferred into 

new tubes. 

(7) The protein concentrations are assessed via Pierce™ BCA Protein Assay Kit 

(Invitrogen) according to the user guide, and the sample concentration is adjusted 

to the same concentration (e.g., 2 mg/mL) with RIPA lysis and extraction buffer. 

(8) Sample loading buffer (4x) and sample reducing agent (10x) are added to the sample. 

(9) The samples are heated at 100°C for 15 min to denaturize proteins and then stored 

at -20°C for future use. 

 

1.6.2 Immunoblotting 

(1) Equal amounts of protein (about 20-30 μg proteins per well) are loaded into the 

wells of precast 4–12% polyacrylamide NuPAGE Bis–Tris gels and adequate 

molecular weight marker. 



(2) The electrophoresis takes place at 200 V for 40 min (See note 9). 

(3) PVDF membranes are activated with ethanol for 30 sec. 

(4) The sandwich for electro-transfer is ordered as follow: Negative electrode-filter 

paper (2 layers)-gels-PVDF membrane-filter paper (2 layers)-positive electrode 

(See note 10). 

(5) The transfer procedure lasts for 1 h at 100 V (See note 11). 

(6) After the transfer, the membranes are blocked with blocking solution for 1 h at room 

temperature on a shaker (See note 12). 

(7) Then membranes are incubated with the primary antibody (according to 

manufacturer’s recommendation) in antibody dilution buffer overnight at 4°C. 

(8) Membranes are rinsed in washing buffer three times, 5 min each (See note 13). 

(9) After the washing steps, membranes are incubated with HRP-conjugated secondary 

antibody at room temperature for 1 h. 

(10)  Membranes are rinsed in washing buffer three times, 5 min each. 

(11)  Visualization of Immunoreactive Bands Using ECL prime Western Blot Detection 

Reagents and acquire images using the ImageQuant LAS 4000 system with 

appropriate software. 

(12)  If necessary, then strip the membrane using a stripping buffer on a shaker for 5-

15 min at room temperature. 

(13)  Membranes are rinsed in washing buffer twice for 5 min each. 

(14)  Membranes are blocked for 1 h in blocking buffer at room temperature. 

(15)  Membranes are incubated with another primary antibody or housekeeping 



proteins.  

(16)  Repeat steps 7-11. 

 

1.6.3 Densitometric analysis 

(1) The ImageJ software is employed for densitometry (https://imagej.net). 

(2) The image is converted into a grayscale image: Image>Type selects 16-bit. 

(3) Background effects are eliminated: Process>Subtract Background. Need for 

background subtraction depends on the source image but a value of 50 suits most 

purposes. 

(4) The quantitative parameters are set: Analyze>Set Measurements, click area, 

average density, and gray value and Integrated Density. 

(5) Set the unit Analyze>Set Scale, enter "pixels" in the box next to "Unit of length". 

(6) A rectangle is employed to mark the first lane to measure the IntDen gray value, 

then move the measurements is repeated on additional lines as described before. 

(7) Relative abundance of proteins is normalized by invariant housekeeping proteins 

(Fig. 1 A,B). 

 

1.7 RT-qPCR validation 

1.7.1 RNA extraction  

(1) After 48 h treatment, the culture medium is removed, and H4 WT cells are washed 

twice by PBS (Note 13).  

(2) PBS is removed, the cells are detached with 0.25% trypsin/EDTA and collected in 



complete medium. 

(3) An appropriate amount of PBS is added to wash the collected samples twice. 

(4) Using a RNeasy Plus MINI Kit to do RNA extraction, all procedure following the 

manufacturing instruction (RNeasy Plus Mini Handbook: www.qiagen.com/HB-

0405). The detailed steps are as follow (See note 15): 

1. Harvest a maximum of 1x107 cells for each sample in a 2 mL tubes. (See note 

16). 

2. Centrifuge the sample tubes at 300 g for 5 min, and then completely aspirate 

the supernatant, and proceed to next step. 

3. The appropriate volume of Buffer RLT Plus is added (<5x106 Buffer RLT Plus 

350 μL, ≤1x107 Buffer RLT Plus 600 μL). Vortex for 30 s or pipet to mix and 

proceed to next step (See notes 17,18).  

4. Transfer the homogenized lysate to a gDNA Eliminator spin column placed in 

a 2mL collection tube (Note Kit supplied). 

5. Centrifuge for 30 s at ≥10,000 rpm (≥8000 g). Discard the column and save 

the flow through. 

6. 600 μL of 70% ethanol are added to the flow through and mix well by pipetting 

(See notes 19,20).  

7. Transfer up to 700 μL of the sample, including any precipitate, to a RNeasy 

spin column placed in a 2 mL collection tube. Then closed the lid and 

centrifuge for 15 s at ≥8000 g (See note 21). Discard the flow through. 

8. 700 μL Buffer RW1 are added to the RNeasy Mini spin column. Close the lid 

http://www.qiagen.com/HB-0405
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and centrifuge for 15 s at ≥8000 g. Discard the flow through (See note 22). 

9. Five hundred μL Buffer RPE are added to the RNeasy spin column and close 

the lid, centrifuge for 15 s at ≥8000 g to wash the spin column membrane. 

Discard the flow through (See note 23). 

10. Five hundred μL Buffer RPE are added to the RNeasy spin column and close 

the lid, centrifuge for 15 s at ≥8000 g to wash the spin column membrane (See 

note 24). 

11. RNeasy spin column is placed in a new 2 mL collection tube and centrifuge at 

full speed for 1min to further dry the membrane. (See note 25)  

12. RNeasy spin column is placed in a new 1.5mL collection tube. Add 30 μL 

RNase-free water directly to the center of spin column membrane and close 

the lid to centrifuge for 1 min at ≥8000 g to elute the RNA. 

13. Elution is repeated with another volume of water or with RNA eluate. (See 

note 26) 

14. The mRNA concentration is quantified and the samples is stored at -80°C for 

later use. (See note 27). 

 

1.7.2 Reverse transcription 

(1) The mRNA concentration is measured by means of a spectrophotometer 

(2) The following components are mixed: 

• 5x Reaction Mix 2 μL. 

• Maxima Enzyme Mix 1 μL. 



• Template RNA 1pg - 2.5 μg. 

• Water, nuclease-free water to 10 μL. 

(3) The sample is mixed well and vortexed for 10 sec. 

(4) PCR reaction procedure: 25°C 10 min, 50°C 30 min, 85°C 5 min. 

(5) After the reverse transcription reaction is complete, samples can be stored at -80°C 

if not directly used. 

 

1.7.3 RT-qPCR 

(1) cDNA concentration is quantified by means of a spectrophotometer 

(2) Primers are diluted to a working concentration of 5 μM 

(3) The following components are mixed: 

• Power SYBR Green PCR Mix 10 μL. 

• Forward primer 2 μL (the final concentration is 500 nM) 

• Reverse primer 2 μL (the final concentration is 500 nM) 

• cDNA template 1 – 100 ng 

• Water, nuclease-free water to 20 μL. 

(4) RT-qPCR procedure 

Step 

Enzyme 

Activation 

PCR 

Cycles (40 cycles) 

Hold Denature Extend 

Time 10 min 15 sec 60 sec 

Temp (°C) 95 95 60 



 

(5) The relative expression of mRNAs is determined after normalization against 

housekeeping genes (Figure 1C) (See note 27) 

 

1.8.1 Functional validation by fluorescence microscopy 

(1) H4 GFP-LC3 cells are diluted in antibiotic-free complete medium at 1x104 cells in 

100 μL/well in Poly-D-lysine precoated 96-well plates for microscopical 

assessment, incubated at 37°C, 5% CO2 overnight and processed the following day. 

(2) After 48 h of RNA interference the cells are treated with rapamycin (RAPA, 10 μM) 

or vehicle for 24 h. 

(3) The cells are fixed with 4% PFA w/v in PBS and nuclei are stained with 10 μg/mL 

Hoechst 33342 at room temperature for 30 min to 1 h. 

 

1.8.2 Image acquisition and analysis 

(1) Images are acquired with a regular or an automated high-throughput fluorescence 

microscope using a 20x objective. A minimum of four view fields should be 

acquired per well, and experiments should be performed in at least triplicate 

assessments. Quantifications are performed in approximately 500 to 1000 cells per 

condition. 

(2) Image segmentation: cells are segmented into nuclear and cytoplasmic regions 

based on the nuclear Hoechst 33342 staining and the GFP-LC3 signal by means of 

image analysis software such as the Custom Module Editor of the MetaXpress 



software, and the average GFP-LC3 dots-surface (fluorescent dots) is quantified in 

the cytoplasmic compartment. 

(3) Dead cells and debris are excluded by gating on normal nuclear size and dim 

Hoechst fluorescence intensity. A minimum of four view fields within one well are 

acquired and image assessments are conducted in at least triplicates. The area of 

GFP-LC3 dots is quantified and mean values for each well are used for further 

statistical analysis. (Fig. 1 E-F) 



Concluding remarks 

The present protocol describes standard methods for assessing a specific knockdown 

mediated by individual interfering RNAs. However, it must be noted that 

immunoblotting is a semiquantitative technique that requires reliable controls, 

experienced experimentation, and repeated evaluations to generate accurate data. Its 

advantage is that it does not dependend on the expression of a transgene and can thus 

be applied to any type of cells. Real-time fluorescent quantitative PCR technology 

refers to the method of adding fluorescent groups to the PCR reaction system, using the 

accumulation of fluorescent signals to monitor the entire PCR process in real time, and 

finally performing quantitative analysis of unknown templates through standard curves. 

Assessing mRNA abundance together with protein expression to observe the effect of 

interfering RNA can accurately verify knockdown efficacy and using these techniques 

for the mechanistic study of autophagy-mediated effects on senescence and ageing will 

help to further delineate their complex interplay. 
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Notes 

1. Alternatively, pooled siRNAs (such as SMARTpooles commercially available from 

Dharmacon) can be employed to achieve efficient knockdown. 

2. Other cell lines may require adjustments in culture conditions. 

3. H4 cells can be split at a ratio of 1:4-1:6 every 3-4 days to reach 70-80% confluency. 

Control of cell culture density (70-80% confluency) is required to prevent genetic 

drift of the original cell line due to metabolic, nutritional, and/or oxidative stress. 

4. Add PBS to wash away residual serum. 

5. Excessive incubation time with trypsin/EDTA may affect cell viability, so when 

digesting cells, enough trypsin/EDTA should be given to detach the cells. And after 

the digestion is complete, the digestion should be terminated in time to avoid 

excessive digestion leading to increased cell debris. 

6. Use PBS to washout extra proteins contained in the medium. 

7. To minimize the effects of protein degradation, all cell lysis reagents and samples 

need to be kept on ice during manipulation. The lysis time should be long enough 

to ensure adequate protein lysis. 

8. Ultrasonication helps to promote complete lysis and dissolution of the sample. 

9. The electrophoresis time may change according to the electrophoresis solution and 

temperature and be careful not to lose the target protein. 

10. The temperature of the transfer solution will increase when transferring the 

membrane. For the transfer effect, it is best to transfer the membrane in a cold 

storage (4°C) or add ice cubes to the transfer membrane box. 



11. The transfer time may vary depending on the target protein, and 1 kDa / 1 min can 

be used to roughly estimate the transfer time. 

12. Blocking for a sufficiently long time can attenuate non-specific bands. 

13. This washing step is to avoid antibody carryover that may cause increased 

background. 

14. The wash step is used to wash out the dead cells. 

15. The entire RNA extraction process needs to be carried out at room temperature. 

16. Too many cells will result in insufficient lysis and the RNA binding capacity of the 

RNeasy spin column will be exceeded. 

17. Vortex for 30 seconds or use a homogenizer to help fully lyse cells and increase 

RNA yields. 

18. Ensure that β-ME is added to Buffer RLT Plus before use. 

19. The volume of ethanol could be adjusted. 

20. Precipitates may be visible after addition of ethanol sometimes. This does not affect 

the procedure. 

21. If there are some buffer remained, reload it after the first-time centrifugation and 

repeat the centrifugation. 

22. After centrifugation, carefully remove the RNeasy spin column from the collection 

tube so that the spin column does not contact with the effluent. Make sure the 

collection tube is completely emptied. 

23. Ensure the ethanol is added to Buffer RPE. 

24. Extended centrifugation dries the spin column, ensure that no ethanol is carried over 



during RNA elution. Residual ethanol may interfere with downstream reactions.  

25. This step is used to reduce salt contamination of the product which may affect the 

final RNA purity. 

26. If the expected RNA yield is >30 µg, repeat the elution step to obtain more RNA or 

higher RNA concentration. 

27. Aliquoting helps to avoid degradation of mRNA caused by repeated freezing and 

thawing. 

28. Quantification of mRNA was calculated as relative fold gene expression by 

employing the 2-CT method. 
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Figure legend 

Figure 1. Knockdown efficacy of siTFE3 assessed by immunoblot, RT-qPCR and 

fluorescence microscopy. Immunoblots of H4 cells treated as indicated were 

performed as described. Band intensities of TFE3 and β-actin were assessed, and their 

ratios were calculated (A,B). RT-qPCR was performed as described in the methods 

section. The relative TFE3 mRNA levels and melt curves are presented in C and D. The 

functional impact of TFE3 knockdown was assessed in H4 cells stably expressing GFP-

LC3. Rapamycin (RAPA) was employed as prototype autophagy inducer and the fold 

change in GFP-LC3 dots surface was assessed by fluorescence microscopy (E,F). Size 

bar equals 10 µm. Data is depicted as mean±SEM of at least three independent 

experiments (p values were calculated using Student’s t-test and One-Way ANOVA). 
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